CHAPTER 16
AutoCAD 3D

PROJECT EXERCISE

This project creates the bracket shown in Figure P16–1. The bracket is drawn entirely by means of AutoCAD solid-modeling features. Follow the steps, and you will be able to build the model by using the various commands available in AutoCAD solid modeling.

Step 1: Begin a new drawing using the acad3D.dwt template. Set the Units to Decimal and the Area to 22 by 17. Set the workspace to 3D Modeling.

Step 2: Create the following layers with appropriate colors and linetypes:

<table>
<thead>
<tr>
<th>Layer Name</th>
<th>Color</th>
<th>Linetype</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object</td>
<td>Red</td>
<td>Continuous</td>
</tr>
<tr>
<td>Border</td>
<td>Green</td>
<td>Continuous</td>
</tr>
<tr>
<td>Dim</td>
<td>Blue</td>
<td>Continuous</td>
</tr>
<tr>
<td>Viewports</td>
<td>Cyan</td>
<td>Continuous</td>
</tr>
</tbody>
</table>
Step 3: Invoke the `VPORTS` command to create four equal viewports. AutoCAD displays the Viewports dialog box. Under **Standard viewports** select *Four Equal*, select 3D in the **Setup**, and for each view (Top, SE Isometric, Front, and Right), set the Visual Style to **3D Hidden** as shown in Figure P16–2. Choose **OK** and the drawing screen appears as shown in Figure P16–3.
Step 4: Make the upper right viewport current. Right-click the ViewCube tool and select the Parallel projection option. Set Object as the current layer.

Begin the layout of the drawing by drawing four boxes. Invoke the BOX command from the Modeling panel on the Home tab. AutoCAD prompts:

Specify corner of box or <0,0,0>: 0,0,-2
Specify corner or (choose LENGTH from the Shortcut menu)
Length: 8 (while the cursor is in the positive X direction)
Width: 7 (while the cursor is in the positive Y direction)
Height: 1 (while the cursor is in the positive Z direction)

Invoke the BOX command again. AutoCAD prompts:

Specify corner of box or <0,0,0>: 0,0,-1
Specify corner or (choose LENGTH from the Shortcut menu)
Length: 3 (while the cursor is in the positive X direction)
Width: 7 (while the cursor is in the positive Y direction)
Height: 1 (while the cursor is in the positive Z direction)

Invoke the BOX command again. AutoCAD prompts:

Specify corner of box or <0,0,0>: 5,0,-3
Specify corner or (choose LENGTH from the Shortcut menu)
Length: 3 (while the cursor is in the positive X direction)
Width: 7 (while the cursor is in the positive Y direction)
Height: 1 (while the cursor is in the positive Z direction)

Invoke the BOX command again. AutoCAD prompts:

Specify corner of box or <0,0,0>: 2.5,3.25,-1
Specify corner or (choose LENGTH from the Shortcut menu)
Length: 0.75 (while the cursor is in the positive X direction)
Width: .5 (while the cursor is in the positive Y direction)
Height: 2 (while the cursor is in the positive Z direction)
The preceding box constructions form the basic shape of the bracket, as shown in Figure P16–4.

**FIGURE P16–4  Creating the basic shape of the bracket**

**Step 5:** To create a cylinder, invoke the CYLINDER command from the Modeling panel. AutoCAD prompts:

Specify center point for base of cylinder or <0,0,0>: 1.5,3.5

Specify radius for base of cylinder or <1.25

Specify height of cylinder or <2 (while the cursor is in the positive Z direction)

**Step 6:** To create a wedge, as shown in Figure P16–5, invoke the WEDGE command from the Modeling panel. AutoCAD prompts:

Specify first corner of wedge or <0,0,0>: 3.25,3.25,-1

Specify corner or < (choose LENGTH from the Shortcut menu)

Length: 3.75 (while the cursor is in the positive X direction)

Width: .5 (while the cursor is in the positive Y direction)

Height: 2 (while the cursor is in the positive Z direction)
Step 7: To define a new UCS, invoke the 3POINT command from the Coordinates panel located in the View tab. AutoCAD prompts:

Specify new origin point \(<0,0,0>\): (select point 1 by using the object snap ENDpoint, as shown in Figure P16-6)

Specify point on positive portion of X-axis: (select point 2 by using the object snap ENDpoint, as shown in Figure P16-6)

Specify point on positive-Y portion of the UCS XY plane: (select point 3 by using the object snap ENDpoint, as shown in Figure P16-6)
Step 8: To draw a polyline to the given coordinates as shown in Figure P16–7, invoke the PLINE command from the Draw panel. AutoCAD prompts:

Specify start point: 3.5,2
Current line-width is 0.0000
Specify next point or @1<180
Specify next point or @0.5<270
Specify next point or @-0.5,-1
Specify next point or @0.5<-90
Specify next point or @1.5<0
Specify next point or (choose CLOSE from the shortcut menu)

FIGURE P16–7 Drawing a polyline to specified coordinates

Step 9: To revolve the polyline just created into a solid, as shown in Figure P16–8, the 4 viewports are changed to the 3D Wireframe style. Invoke the REVOLVE command from the Modeling panel. AutoCAD prompts:

Select objects: l (this is a lower case L for last object drawn, which was the polygon)
Select objects: (ENTER)
Specify start point for axis of revolution or define axis by [Object/X (axis)/Y (axis)]: 3.5,2
Specify endpoint of axis: @2<270
Specify angle of revolution <360>: 180
Step 10: To create two spheres, change the UCS to World by choosing World in the Coordinates panel of the View tab and then invoke the SPHERE command from the Modeling panel. AutoCAD prompts:

```
sphere
Specify center of sphere <0,0,0>: 1.5,1.125,-0.5
Specify radius of sphere or 1
```

Copy the sphere to a displacement of 0,4.75, as shown in Figure P16–9.

Invoke the COPY command from the Modify panel. AutoCAD prompts:

```
Select objects: 1
Select objects: (ENTER)
Specify base point or displacement, or 0,0
Specify second point of displacement or <use first point as displacement>: 0,4.75
```
**Step 11:** To draw two cones, as shown in Figure P16–10, invoke the CONE command from the Modeling panel. AutoCAD prompts:

- Specify center point for base of cone or \( \langle 0,0,0 \rangle \):
  - 1.5,1.125,-2
- Specify radius for base of cone or \( r \):
  - 0.75
- Specify height of cone or \( h \):
  - -3

Copy the cone to a displacement of 0,4.75.

**FIGURE P16–10** Drawing two cones using the CONE command

**Step 12:** Starting at 0,0,–5, create a box that is 3 × 7 × 2, as shown in Figure P16–11.

**FIGURE P16–11** Creating a box with dimensions of 3 × 7 × 2
Step 13: Create a 0.5-radius cylinder, centered at 1.5,3.5,-2, to a height of 4, as shown in Figure P16–12.

![Figure P16–12 Creating a 0.5 cylinder with a height of 4](image)

Step 14: Create a cylinder with radius 1, centered at 1.5,3.5,1.75 to a height of 0.25, as shown in Figure P16–13.

![Figure P16–13 Creating a cylinder with a height of 0.25 and a radius of 1](image)

Step 15: Create a cylinder with radius 0.25, centered at 6.5,1.0,-3 to a height of 2, as shown in Figure P16–14. Copy the cylinder to a displacement of 0,4.
Step 16: To create a torus, as shown in Figure P16–15, invoke the **TORUS** command, from the Modeling panel. AutoCAD prompts:

Specify center of torus <0,0,0>: 1.5,3.5,1.5
Specify radius of torus or \[ ] 1.25
Specify radius of tube or \[ ] 0.25

Step 17: Select the connected boxes (except the box that was drawn in step 12), the wedge, the large cylinder, the spheres, and the cones for use with the **UNION** command.

union (enter)
Select objects: (select the boxes, wedge, large cylinder, spheres, and cones, and press ENTER)
Step 18: Select the resulting solid in response to the first SUBTRACT prompt, and then select the remaining primitives to be subtracted from it.

```
subtract (ENTER)
Select solids and regions to subtract from...
Select objects: (select the solid resulting from STEP 18)
Select objects: (ENTER)
Select solids and regions to subtract...
Select objects: (select the remaining primitives)
Select objects: (ENTER)
```

After changing the Visual Style in the 4 viewports to 3D Hidden, the drawing should look like Figure P16–16.

![Figure P16–16](image)

**FIGURE P16–16** Subtracting the primitives from the newly created solid using the SUBTRACT command

Step 19: Select the faces, as shown in Figure P16–17, for the chamfer and fillet. Use the CHAMFER and FILLET commands with 0.25 as the chamfer values and as 0.25 as fillet radii on the respective selected objects. The end result should look like Figure P16–18.
Step 20: Make the upper right viewport active. Invoke the \texttt{HIDE} command, and the result is as shown in Figure P16–19.

\textbf{FIGURE P16–17} Using the \texttt{CHAMFER} and \texttt{FILLET} commands to chamfer and fillet the faces

\textbf{FIGURE P16–18} The solid after chamfering and filleting the faces
Step 21: Set Viewports as the current layer. Invoke the LAYOUTWIZARD command to create a layout to plot model. AutoCAD displays the Create Layout – Begin dialog box, as shown in Figure P16–20.

FIGURE P16–19  Completed solid after using the HIDE command

FIGURE P16–20  Create Layout – Begin dialog box
Type **Chapter16 Project Layout** in the **Enter a name for the new layout you are creating** edit field, as shown in Figure P16–20. Choose **Next**, and AutoCAD displays the Create Layout – Printer dialog box, as shown in Figure P16–21.

![Create Layout – Printer dialog box](image1)

**FIGURE P16–21** Create Layout – Printer dialog box

Select a printer from the **Select a configured for the new layout** list box. In Figure 16–21, 7580b.pc3 is selected. Choose **Next**, and AutoCAD displays the Create Layout – Paper Size dialog box, as shown in Figure P16–22.

![Create Layout – Paper Size dialog box](image2)

**FIGURE P16–22** Create Layout – Paper Size dialog box
Select a paper size to be used in plotting. In Figure P16–22, ANSI C (22.00 × 17.00 Inches) is selected. Choose **Next**, and AutoCAD displays the Create Layout – Orientation dialog box, as shown in Figure P16–23.

![Create Layout – Orientation dialog box](image)

**FIGURE P16–23** Create Layout – Orientation dialog box

Select **Landscape**, as shown in Figure P16–23. Choose **Next**, and AutoCAD displays the Create Layout – Title Block dialog box, as shown in Figure P16–24.

![Create Layout – Title Block dialog box](image)

**FIGURE P16–24** Create Layout – Title Block dialog box
Select the appropriate title block for the selected paper size. Choose Next, and AutoCAD displays the Create Layout – Define Viewports dialog box, as shown in Figure P16–25.

![Create Layout – Define Viewports dialog box](image1)

**FIGURE P16–25**  Create Layout – Define Viewports dialog box

Select **Std. 3D Engineering Views** in the **Viewport setup** section of the dialog box, as shown in Figure P16–25. Choose **Next**, and AutoCAD displays the Create Layout – Pick Location dialog box, as shown in Figure P16–26.

![Create Layout – Pick Location dialog box](image2)

**FIGURE P16–26**  Create Layout – Pick Location dialog box
Choose Select Location. AutoCAD prompts:

Specify first corner: 1.5, 2.5
Specify opposite corner: #20, 14

AutoCAD displays the Create Layout – Finish dialog box. Choose Finish.
AutoCAD displays three orthographic views and an isometric view in four viewports.
Set the Layer object as the current layout and turn off the viewport layer.
Invoke the PLOT command and plot the drawing.

Step 22: Save and close the drawing.
EXERCISE 16–1

Lay out the objects shown in 3D form for Exercises 16–1 to 16–5. Create the drawings to the given dimensions. Display the drawing with VPOINT in four different views. Select the **HIDE** command for one of the views.

FIGURE EX16–1
EXERCISE 16–2

FIGURE EX16–2
FIGURE EX16–3
EXERCISE 16–4

FIGURE EX16–4
EXERCISE 16–6
Lay out the 4" 150 slip-on flange drawing shown in Figure Ex16–6 to the given dimensions.

FIGURE EX16–6  Slip-on flange
EXERCISE 16–7
Lay out the clevis drawing shown in Figure Ex16–7 to the given dimensions.

FIGURE EX16–7  Clevis
EXERCISE 16–8

Lay out the drawing shown in Figure Ex16–8 to the given dimensions.

FIGURE EX16–8
EXERCISE 16–9

Lay out the drawing shown in Figure Ex16–9 to the given dimensions.

FIGURE EX16–9
EXERCISE 16–10

Lay out the drawing shown in Figure Ex16–10 to the given dimensions.

FIGURE EX16–10
EXERCISE 16–11

Lay out the drawing shown in Figure Ex16–11 to the given dimensions.

FIGURE EX16–11
EXERCISE 16–12

Lay out the drawing shown in Figure Ex16–12 to the given dimensions.

FIGURE EX16–12
EXERCISE 16–13
Create the drawing shown in Figure Ex16–13 of the tank with supports on a slab.

FIGURE EX16–13  Tank with supports on a slab
EXERCISE 16–14

Create the drawing of the 2", 3", 4" and 6" schedule 80 pipe on concrete supports.

FIGURE EX16–14  2", 3", 4", and 6" schedule 80 pipe on concrete supports
EXERCISE 16–15
Create the pressure vessel drawing shown in Figure Ex16–15.

HINT
All extension pipes are 8" O.D.

FIGURE EX16–15  Pressure vessel